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Parts of the Word Window
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Word 2007's workspace offers many interactive choices.
· The Office button includes: opening, saving, printing, finishing, and publishing options.
· The title bar displays the name of the document.
· The different tabs display the different ribbons.
· Each ribbon contains buttons associated with functions.
· The buttons in a ribbon are split into groups which make them easier to find.
· The quick access toolbar contains popular buttons. The user can add buttons to the toolbar.
· The default buttons are Save, Undo, and Repeat.
· There are both a horizontal and a vertical ruler. Notice page margins are blue whereas the body area is shown in white on the rulers.
· The status bar provides information about the document.
· View buttons are shortcuts to the most popular document views.
· The zoom slider controls the size of the document on the screen.
· A smaller view shows more of the page whereas a closer view is easier to read.
· The vertical scrollbar scrolls through the entire document. Hover the mouse over the slider and the page number.
Word Wrap
[image: word wrap]
· Hard return - user presses enter key
· Soft return - program wraps text from line to line
Word automatically moves to the next line when it reaches the margin of the page and moves the entire word to the next line. This is called a soft return and updates if the characters per line change (for example, the font size or the margins change).
Enter a hard return in one of two ways:
· The first way is to use the Enter key on the keyboard to complete a paragraph and start the new paragraph on a new line. With the Show/Hide button on, a paragraph mark is displayed.
· Second, the keyboard combination of Shift+Enter adds a line break, yet does not start a new paragraph. All paragraph level changes will apply before and after the return. With the Show/Hide button on, a curling arrow is displayed to denote a line break.
AutoText
[image: auto text]
AutoText contains predefined entries that Word suggests as a ScreenTip whenever the program identifies the possible beginning of an entry in its registry, such as the date shown above.
To insert the suggested text, press the Enter key and the text will be inserted. If the ScreenTip is incorrect and should not be added, simply ignore the ScreenTip and continue typing.
Examples of AutoText include:
· Weekdays
· Dates
· Dear Sir or Madam:
Building Blocks
[image: build blocks]
Produce personal AutoText entries through the building block dialog box.
Highlight the text to be added and choose Quick Parts to open the Create New Building Block dialog box.
Name the block and choose to place it in the AutoText gallery. Add the block to a category if appropriate.
To use the Building Block, type the first part of the entry and then press F3.
 
Date and Time
[image: date time]
On the Insert ribbon in the Text group, choose Date & Time. The Date and Time dialog box displays a multitude of formats. Choose one that is appropriate for the document.
To update the date and time whenever the file opens, select Update automatically.
The date and time will remain static if Update Automatically is not selected.
Date and Time uses the computer’s internal clock to insert the date and time
Views
[image: views]
The View buttons on the status bar are a collection of different ways to look at the document.
The views are:
· Print Layout View, which shows a document as it will print. All printed portions of the document will be visible, including headers and footers.
· Full Screen Reading View is the view for reading on screen. This view reflows the document and only shows body text. Documents opened from the Internet are opened in full screen reading view.
· Web Layout shows the document as a web page.
· Master Document Tools View shows an outline based on the style heading that was used in the document. This view is also used when producing a Master document and subdocuments.
· Draft View is similar to what was previously known as normal view. The body of the document without headers and footers is displayed. This view does not show page breaks unless they have been manually added.
Zoom
Zoom Slider
[image: zoom slider]
 
The Zoom slider zooms the document in or out. Move the slider left and right to make the screen image of the document larger or smaller.
Zoom Tool
[image: zoom tool]
The Zoom tool in the Zoom group on the View ribbon also changes the document’s size on screen. Choose one page, two pages, or by page width.
Click the magnifying glass itself to get the zoom dialog box. In the dialog box, there are more viewing choices. Zoom by percentage, text width (minus the margins), width page or many pages (which shows more than one page on the screen).
· Choose the number of pages to view and Word will choose the optimal zoom percentage
Mini Toolbar 
[image: mini toolbar]
· Displays when text is selected or right-clicked
· Contains frequently used formatting commands
The Mini toolbar appears when text is selected or right-clicked. It contains frequently used formatting commands.
		Formatting options include:

	· Font face
· Font size
· Font color
· Bold
· Italic
	· Center text
· Increase indent
· Decrease indent
· Bullets
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	Video: Mini Toolbar

	The Mini toolbar appears faintly as you hover over text and becomes more visible when you move the mouse toward it.





Save As 
[image: save as]
· Save – replaces the existing (original) file
· Save As – creates a new file, leaving the existing (original) file intact
As changes are made to the document, they do not become part of a document’s file until they are saved.
Choose to save a document to a file in one of three ways: Click the Office button and select Save; Select the save button in the Quick Access Toolbar; or type Ctrl+S on the keyboard.
Save replaces the existing (original) file and the previous version is discarded.
When a document is saved for the first time, the Save As dialog box is displayed. Choose a descriptive name for the file. Note: if the file will be put on a web server, be sure the name does not contain spaces. Use the underscore key instead.
To keep the previous file intact, use Save As from the Office button menu. Rename the file or put it in a new location on the hard drive. Now the previous version and the new version are both accessible.
To save a file for others who are using previous versions of Word, use the Save As dialog box and choose the correct version in the “save as type” area.
Page Orientation 
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On the Page Layout ribbon in the Page Setup group, choose Orientation. Choose to set up the document’s orientation to either Portrait or Landscape.
Portrait is taller than it is wide, whereas landscape is wider than it is tall. Documents tend to be set to Portrait more often than landscape.
Each section of the document may be oriented differently.
Margins 
[image: margins]
· Margins are the white space around the top, bottom, left- and right-hand sides of the document
Most, if not all printers, cannot print to the edge of a page. The printer requires a grip area where the paper is held. This area varies from printer to printer, but ¼ of an inch is a normal grip requirement.
Margins are the spaces between the edge of the paper and the text on the page.
Margins give space to a document and make it easier to read. Generally, they are larger than ¼ of an inch for the sake of design and readability.
On the Page Layout ribbon in the Page Setup group, select Margins. Choose either a preset margin or create a Custom Margin.
If a document will be printed on both sides and bound (like a book), select a Mirrored margin. Notice Left and Right have been replaced by Inside and Outside. Inside is the portion of a the page that will be bound, whereas outside is the outside edge of the document. Give the inside margin a wider allowance for the binding.
If none of the options are appropriate for the document, choose Customize Margins and make margin choices in the Margins tab of the Page Setup dialog box.
Page Breaks
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· Word inserts a soft page break when text reaches the bottom of the page, continuing text onto the next page
· Insert a page break to start a new page where a new one should begin
When a document reaches the end of a page, Word automatically moves the text to the next page. This is a soft page break. As with the soft wrap, the page break can change when new formatting is applied or if text is inserted in a document.

A hard page break is added by the user to begin a new page. On the Insert Ribbon, in the Pages group, select Page Break. Word ends the paragraph and adds the page break to the document. The rest of the page after the break is blank and the next text begins on a new page.
Page Numbers 
[image: page numbers]
· Use the page number button to add a page number field to the header or footer
On the Insert ribbon in the Header & Footer group, select Page Number to insert a page number field into the header or footer.
Choose a design for the header or footer from the gallery. Directly open the headers and footers at the bottom of the gallery to make further changes.
Format page numbers using Format Page Numbers from the menu. Choose a Number format. Include chapter (section) number if appropriate and set the numbering system to Continue from a previous section or choose a number to start at.
Headers and Footers
· On the Insert tab, in the Header & Footer group, choose either Header or Footer
· Headers and footers always exist whether content is in them or not
· Make different headers and footers throughout the document using section breaks
Section Breaks 
[image: section breaks]
· Similar to page breaks, but sections are separate parts of a document and can make specific changes such as:
· Headers and footers
· Margins
· Page orientation (portrait and landscape)
· Page size
· Columns
On the Layout ribbon in the Page Setup group, click on Breaks. Section breaks may be similar to page breaks except they break the document into discriminate sections rather than simply starting a new page within the same section.
Section break options are:
· Next Page, which starts a new section on a new page
· Continuous, which starts a new section at the insertion point on the page without moving to a new page
· Even Page, which starts the new section on the next even page
· Odd Page, which starts the new section on the next odd page
Section breaks are used instead of Page Breaks when there needs to be a change to one of the portions of a document:
· Header
· Footer
· Margin
· Page orientation
· Page size
· Column setup
Cover Pages 
[image: add cover page]
· Adding a cover page adds a special section to the document
· Choose the design
· Modify as needed
A cover page is a special section of the document. On the Insert tab in the Pages group, select cover page and the cover page gallery is displayed. Choose a design and modify it to fit the document. Once the changes to the cover page are made, add the cover page design to the gallery for future use by selecting the Cover Page button again and selecting Save Selection to cover Page Gallery. This adds the new design to the gallery for future use.
Notice that at the end of the cover page, a page break is added. The header and footer are not shown on a Cover Page.
Find and Replace
[image: find replace]
· Find a part of a document
· Replace unwanted text with something new in a document
· Replace All globally replaces unwanted text throughout the document
On the Home tab in the Editing Group, select either Find or Replace. Both buttons open the same Find and Replace dialog box. This is a very powerful part of Word. Find and change one word to another. Simply type the word to be found in Find what and type what is to be replaced in Replace with. Click Find next to find the next occurrence of the word. Click Replace to replace the word. Select Replace All to replace every occurrence of the word.
There are many options in Find and Replace. Click on the More button to see all the options available. Limit the find using the Search Options. Use the Special button to find and replace special characters or formatting characters (such as the paragraph mark, tabs or Em dashes).
Options include:
· Match case to be sure the word found is exactly as typed (for instance, using match case to find the word “Pencil” will only find “Pencil”, but will not find “pencil”).
· Find whole words will only find Pencil, but not Pencils or Pencilcase.
· Sounds like finds words that sound similar, such as their, they’re and there.
Be careful when using Replace All. Unless you are absolutely sure the search will find and change only what is needed, it is better make changes one at a time, using the Replace button.
Spelling and Grammar
[image: spelling grammar]
· Questionable spelling is underlined in red
· Contextual spelling questions are underlined in blue
· Questionable grammar is underlined in green
Squiggly lines under portions of text identify misspelled words or questionable grammar. Red lines question the spelling, blue lines question the word use, and green lines question the grammar.
Right click on an underlined word to be given options for fixing the error or use Spell and Grammar check once the document is completed.
To run the Spell and Grammar check, click the Spelling and Grammar button in the Proofing group on the Review ribbon to get the Spelling and Grammar dialog box. Notice that the language in which the dialog box will proof is provided on the dialog box title bar.
Click the Check grammar check box to check grammar as well as spelling.
Word has a new contextual spelling engine which catches problem words that aren’t necessarily spelled wrong, but are used incorrectly. For example, it’s and its are often misused. Contextual spell checker finds these problems. Contextual spelling questions are shown in blue, whereas words that are simply misspelled appear in red.
Grammar check highlights grammatical errors. If Word understands the problem with the sentence, it will suggest a solution. Revision of sentences by the writer, however, is easily accomplished. Extremely long sentences can confuse the grammar check engine even if they are grammatically correct. Consider revising these sentences as well.
Document Inspector
[image: document inspector]
To open Document Inspector, click on the Office Button and mouse over Finish. In the submenu, choose Inspect Document.  This opens Document Inspector. Document Inspector checks for myriad items, including:
· Comments, Revisions, Versions, and Annotations
· Document Properties and Personal Information
· Custom XML Data
· Headers, Footers, and Watermarks
· Hidden Text
Once the document has been inspected, choose which items to remove before publishing. Only remove unwanted information.
Document Inspector can make sure hidden and personal information is stripped from the document before it is published.
Be sure to use Save As when saving inspected documents to keep a copy containing the original data that may be needed for other purposes.
Saving for Different Versions
[image: save different versions]
When saving to earlier versions of Word, use Save As and choose the appropriate version in the Save as Type dropdown menu. Certain portions of 2007 documents may be different in previous versions and some formatting may be lost.
The 2007 document extension is .docx, whereas previous versions have the .doc extension.
Users of previous versions are able to download the Word Compatibility pack; with it installed, they will be able to view 2007 documents.
Printing
[image: printing]
To get to the print screen, click on the Office Button and choose Print, or type Ctrl+P on the keyboard to open the print screen.
When printing documents, be sure to preview them first. Select the Office Button, Mouse over the arrow next to Print and choose Print Preview from the list. Many errors can be found on-screen and previewing will save resources.
Choose the printer from the drop-down list or find a printer on the network using the appropriate button on the dialog box.
Print multiple pages per sheet, only odd pages, or only even pages. Scale the document to print the document smaller.
Choose the pages to print (All, Current Page or choose a page range) and decide how many copies of the document to print. The default is 1.
Finally, select OK and the document will print to the selected printer.
Customizing Word
[image: customize word]
Word works well out of the box, but you may find that you want to customize it.
Click the Office button and choose Options for the Word Options dialog box.
Once in Word options, you can customize many areas of Word.
[bookmark: _GoBack]
image2.gif
Ribbon Titie bar

s, e ot e

ot e =





image3.gif
Hard retums:

Margin changes
do not affect the
hard retums
i o s et st
you s g I e vt o ke Socmn forming. T
Soft returns: P o e a1t v e e s, s o
Nolice the postion Erentoesty nsc o g
of the soft returns
change at the ot vrp s et e cominnndyvithon v hin 0wy et

1| i e e A o i e decumet e o b ot e

POINt OF the MAIGIN (o, e o 11 ok ou s o e ey o nd of s puag b
change e s e e dosmn §

o psionof b o e  haged sty sy ke chinges

I he et o the document formatting. The posiion ofth hard revms vy remaas the

e s you oy s o ke the ¢




image4.gif
A chaplhot_credt soktion doox - MrosoR Word —TeYXY
e e

P
e —— -
e

Requires user action fo insert





image5.gif




image6.gif
© L

cere 3 (| BY ) 1 gl B

pee

A ] 3 var Rsowine Ttsmen

B P el vl e
- o e e e b

Click Date & Time
to insert the date

and/or time
Choose a
format for the
date and/or time Choose Update
automatically to have the date

and time update every time
the file opens





image7.gif
+ o e g

) Thecard e ot s e “parodi e o opled o you otstanding Baence o e he
ptarvestuivessmio
i Sonerecus o e o e oo A9 e st s e
- che. e e e g ek i, s et
g ol s e o oo e et et o o 4P g
- o o et st s s, "0
St it e B P





image8.gif
e o e 0 G e “Bariod i D 1t shed 1 Your v B 1 Rt e

O —————
s asipaiabephiusdreistiemnbiispinpeionny
- T e o o ety e o 410 rsrts

« ot o gt
oo et ket st b s, g st
St it i




image9.gif
Open Zoom
dialog box

Ot
Otetman
Owabsom





image10.gif
B
hccox AaBbC A \ | e
5 T—— E
¥

@ T

|
i s ot e M s o i el e b I
T A A Gu b i





image11.gif
Choose the file





image12.gif
W 10a djdidf docx - Microsoft Word
».......‘|-m Setencs votogs sesen_vew _ hdsin:





image13.gif
R 05

Rowe 175

Click the Margins button and
display the margins gallery

Create Custom Margins._.





image14.gif
e
Ceenn s .

This only shows
up when





image15.gif
Choose placement ————=-"""11
inthe header -

or the footer —1

o |

LN J

i

Format page numbers to
adjust numbering or make
other formatting changes





image16.gif




image17.gif
‘Documentd - Microsot Word i

DD D) (A d0ene A Kisser-

= G Do
Bl S o dsoma-





image18.gif
foaany

Py o .

e
M r Uk A% A B E A

Select Options

Use Special to

find or repiace

unusual characters.
or use wildcard

options




image19.gif




image20.gif




image21.gif




image22.gif
2 M8 s s e B

e e i i s 1 O b

-




image23.gif
B e e R

1 misevencnsose B s

15 mocaonmen 19 unee
ﬁrm—- " [0 neso

& wenars 5 macaoocmen
‘ trosucion Focus

‘A o gk

7 e

ncsun
npanee onstency e

TYNY | [Eoroe

: =
H

> IR
i
H
i





image1.jpeg




